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1) Rotate the ENTER knob to select [+0.00 kHz] then push the knob.

2) Rotate the ENTER knob to adjust the receiving frequency (setting value: -0.20 
to +0.20). 

6.13 External Alarm Setting
The [EXTERNAL ALARM] menu enables/disables output of the contact signal for ur-
gency, safety and routine frequencies to an external alarm system.

1. Rotate the ENTER knob to select [SYSTEM] on the [MENU] screen then push the 
knob.

2. Rotate the ENTER knob to select [EXTERNAL ALARM] then push the knob.

3. Rotate the ENTER knob to select [URGENCY], [SAFETY] or [ROUTINE], then 
push the knob.

4. Rotate the ENTER knob to select [ON] or [OFF] then push the knob.

6.14 NETWORK Setting
View your network settings on the [NETWORK SETTING (VIEW)] screen.

1. Rotate the ENTER knob to select [SYSTEM] on the [MENU] screen then push the 
knob.

2. Rotate the ENTER knob to select [NETWORK] then push the knob.
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6.15 Address Book
You can register a maximum of 50 MMSI or the address name (max. 20 letters) in the 
memory.

6.15.1 List for address data
1. Rotate the ENTER knob to select [DSC] on the [MENU] screen then push the 

knob.
2. Rotate the ENTER knob to select [ADDRESSBOOK] then push the knob.

6.15.2 How to register addresses
1. Open the [ADDRESS BOOK] screen.
2. Press the 5 key to open the [ADDRESS DATA ENTRY] screen.

Key/knob Function

ENTER • Move the cursor by rotating the ENTER knob.
• Open the [ADDRESS DATA EDIT] screen by pushing the ENTER 

knob (see paragraph 6.15.3)..

CANCEL Return to the [MENU] screen.

1 Go to the previous page.

3 Go to the next page.

4 Delete address (see paragraph 6.15.4).

5 Open the [ADDRESS DATA ENTRY] screen (see paragraph 6.15.2).

6 Switch the address type. Each press changes the type continuously 
(SHIP → COAST → GROUP → SHIP → ...).

When 50 addresses 
are registered, this 
is not available.
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3. With [NAME] selected, push the ENTER knob.

4. Enter the address name (max. 20 letters) with the numeric keys then push the EN-
TER knob.

5. With [MMSI] selected, push the ENTER knob.

6. Enter the MMSI with the numeric keys then push the ENTER knob.
7. With [REGISTER] selected, push the ENTER knob.

6.15.3 How to edit addresses
1. Open the [ADDRESS BOOK] screen.
2. Rotate the ENTER knob to select the address to edit then push the knob.

3. Rotate the ENTER knob to select [NAME] or [MMSI] as appropriate then push the 
knob.

4. Enter the address name or MMSI with the numeric keys then push the ENTER 
knob.

5. Rotate the ENTER knob to select [REGISTER] then push the knob.

Note: If the MMSI is already registered to another address, the error alarm sounds 
and a warning pop-up message appears when selecting [REGISTER].

6. Rotate the ENTER knob to select [Yes] then push the knob.

Push 
the 
ENTER 
knob.LIST

: 24 : 20 : 6

MMSI number overlaps.
               : Close window
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6.15.4 How to delete addresses
Open the [ADDRESS BOOK] screen then follow the applicable procedure below.

Individual address

1. Rotate the ENTER knob to select the address to delete then press the 4 key.

2. With [DELETE SELECTION] selected, push the ENTER knob.

3. Rotate the ENTER knob to select [Yes] then push the knob.

Address by type

1. Press the 6 key several times to select desired type.
2. Press the 4 key.
3. Rotate the ENTER knob to select [DELETE LIST] then push the knob.
4. Rotate the ENTER knob to select [Yes] then push the knob.

All addresses

1. Press the 4 key.
2. Rotate the ENTER knob to select [DELETE ALL LISTS] then push the knob.
3. Rotate the ENTER knob to select [Yes] then push the knob.

6.15.5 How to create a DSC message with registered address
1. Open the [ADDRESS BOOK] screen.
2. Rotate the ENTER knob to select the address to use.
3. Press the OTHER DSC MSG key to open the [COMPOSE MESSAGE] screen.

Press 
the 
OTHER 
DSC 
MSG 
key.

N06 HNKYU

LIST

: 24 : 20 : 6
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6.16 TX Message Preparation
For the individual, PSTN, group and test messages, you can create messages and 
store them in the memory for future use. You can edit, send or delete these messages. 
A maximum of 100 messages can be stored into the memory.

6.16.1 List for message files
1. Rotate the ENTER knob to select [DSC] on the [MENU] screen then push the 

knob.
2. Rotate the ENTER knob to select [MSG FILE] then push the knob.

Detailed information screen for message files

Rotate the ENTER knob to se-
lect the message file desired 
on the [MESSAGE FILE] list 
then push the knob. The de-
tailed information screen for 
the selected message file ap-
pears as shown right.

Several functions can be done 
from this screen.

• 1 key: Go to the detailed in-
formation screen for the previous message file.

Key/knob Function

ENTER • Move the cursor by rotating the ENTER knob.
• Open the detailed information screen for the selected message file by 

pushing the ENTER knob (see the following "Detailed information 
screen for message files").

CANCEL Return to the [MENU] screen.

1 Go to the previous page.

3 Go to the next page.

4 Delete messages (see paragraph 6.16.8).

5 Open the [MESSAGE FILE ENTRY] screen.

6 Switch the message type. Each press changes the type continuously 
(INDIVIDUAL → GROUP → PSTN → TEST → INDIVIDUAL → ...).

When 100 messages 
are registered, this is 
not available.

10
70 29
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• 3 key: Go to the detailed information screen for the next message file.
• 4 key: Delete the selected message file. The following message appears on the 

screen.

Rotate the ENTER knob to select [Yes] then push the knob.

6.16.2 Individual calls
1. Open the [MESSAGE FILE] list.
2. Press the 5 key to open the [MESSAGE FILE ENTRY] screen.

3. With [MSG TYPE] selected, push the ENTER knob.

4. Rotate the ENTER knob to select [INDIVIDUAL MSG] then push the knob.
5. With [TO] selected, push the ENTER knob.
6. Rotate the ENTER knob to select [DIRECT INPUT] or [ADDRESS BOOK DATA] 

then push the knob.
[ADDRESS BOOK DATA]: Select a MMSI from the [ADDRESS BOOK] (see 
section 6.15) then push the ENTER knob.
[DIRECT INPUT]: Enter the MMSI of coast station or ship station with the numeric 
keys then push the ENTER knob.

7. With [COMM MODE] selected, push the ENTER knob.
8. Rotate the ENTER knob to select the communication mode then push the knob.
9. Rotate the ENTER knob to select [DSC FREQ] then push the knob.
10. Rotate the ENTER knob to select DSC frequency referring to "How to set DSC fre-

quency" on page 5-2 then push the knob. The communication frequency changes 
in conjunction with DSC frequency. If you change the communication frequency, 
go to step 11. If not, go to step 13.

11. Rotate the ENTER knob to select [COMM FREQ] then push the knob.

12. Set the communication frequency referring to "How to set working channel, fre-
quency" on page 5-3 then push the ENTER knob.
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13. Rotate the ENTER knob to select [FILE NAME] then push the ENTER knob.

14. Enter the file name (max. 20 letters) with the numeric keys.
15. With [REGISTER] selected, push the ENTER knob.

6.16.3 Group calls
To receive group calls, register the group MMSI as follows:

1. Open the [MESSAGE FILE] list.
2. Press the 5 key to open the [MESSAGE FILE ENTRY] screen.
3. With [MSG TYPE] selected, push the ENTER knob.
4. Rotate the ENTER knob to select [GROUP MSG] then push the knob.
5. With [TO] selected, push the ENTER knob.
6. Enter the group MMSI (eight digits) with the numeric keys then push the ENTER 

knob.
7. With [COMM MODE] selected, push the ENTER knob.
8. Rotate the ENTER knob to select [TELEPHONE] or [NBDP-FEC] then push the 

knob.
9. Rotate the ENTER knob to select [DSC FREQ] then push the knob.
10. Rotate the ENTER knob to select DSC frequency referring to "How to set DSC fre-

quency" on page 5-2 then push the knob. The communication frequency changes 
in conjunction with DSC frequency. If you change the communication frequency, 
go to step 11. If not, go to step 13.

11. Rotate the ENTER knob to select  [COMM FREQ] then push the knob.
12. Set the communication frequency referring to "How to set working channel, fre-

quency" on page 5-3 then push the ENTER knob.
13. With [FILE NAME] selected, push the ENTER knob.
14. Enter the file name (max. 20 letters) with the numeric keys.
15. With [REGISTER] selected, push the ENTER knob.

6.16.4 PSTN calls
1. Open the [MESSAGE FILE] list.
2. Press the 5 key to open the [MESSAGE FILE ENTRY] screen.
3. With [MSG TYPE] selected, push the ENTER knob.
4. Rotate the ENTER knob to select [PSTN MSG] then push the knob.
5. With [TO] selected, push the ENTER knob.
6. Enter the MMSI of coast station (seven digits) with the numeric keys then push the 

ENTER knob.
7. With [TEL] selected, push the ENTER knob.
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8. Enter the telephone no. (up to 16 digits) with the numeric keys then push the EN-
TER knob.

9. With [DSC FREQ] selected, push the ENTER knob.
10. Rotate the ENTER knob to select DSC frequency referring to "How to set DSC fre-

quency" on page 5-2 then push the knob.
11. With [FILE NAME] selected, push the ENTER knob.
12. Enter the file name (max. 20 letters) with the numeric keys.
13. With [REGISTER] selected, push the ENTER knob.

6.16.5 Test call
1. Open the [MESSAGE FILE] list.
2. Press the 5 key to open the [MESSAGE FILE ENTRY] screen.
3. With [MSG TYPE] selected, push the ENTER knob.
4. Rotate the ENTER knob to select [TEST MSG] then push the knob.
5. With [TO] selected, push the ENTER knob.
6. Rotate the ENTER knob to select [DIRECT INPUT] or [ADDRESS BOOK DATA] 

then push the knob.
[ADDRESS BOOK DATA]: Select a MMSI from the [ADDRESS BOOK] (see 
section 6.15) then push the ENTER knob.
[DIRECT INPUT]: Enter the MMSI where to send the test message with the nu-
meric keys then push the ENTER knob.

7. With [DSC FREQ] selected, push the ENTER knob.

8. Rotate the ENTER knob to select DSC frequency desired then push the knob.
9. With [FILE NAME] selected, push the ENTER knob.
10. Enter the file name (max. 20 letters) with the numeric keys.
11. With [REGISTER] selected, push the ENTER knob.

6.16.6 How to edit prepared messages
1. Open the [MESSAGE FILE] list.
2. Rotate the ENTER knob to select the message file to edit then push the knob.



6.  MENU OPERATION

6-20

3. Push the ENTER knob to open [MESSAGE FILE EDIT] screen.

4. Rotate the ENTER knob to select the item to edit then push the knob.
5. Change the setting accordingly.
6. Rotate the ENTER knob to select [REGISTER] then push the knob.

7. Rotate the ENTER knob to select [Yes] then push the knob.

6.16.7 How to send prepared messages

How to send without modification

1. Open the [MESSAGE FILE] list.
2. Rotate the ENTER knob to select the message file desired then press the OTHER 

DSC MSG key.
3. Rotate the ENTER knob to select [GO TO CALL] then push the knob.

Edit before sending

Follow the procedure in paragraph 6.16.6 and do the above procedure "How to send 
without modification".

6.16.8 How to delete prepared messages

Individual prepared message

Open the [MESSAGE FILE] list then follow the applicable procedure below.

1. Rotate the ENTER knob to select the file to delete then press the 4 key.

2. With [DELETE SELECTION] selected, push the ENTER knob.

3. Rotate the ENTER knob to select [Yes] then push the knob.
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Prepared messages by type

1. Press the 6 key several times to select the desired type.
2. Press the 4 key.
3. Rotate the ENTER knob to select [DELETE LIST] then push the knob.
4. Rotate the ENTER knob to select [Yes] then push the knob.

All prepared messages

1. Press the 4 key.
2. Rotate the ENTER knob to select [DELETE ALL LISTS] then push the knob.
3. Rotate the ENTER knob to select [Yes] then push the knob.

6.17 How to Set the AUTO ACK Details
The acknowledgement message can be sent automatically when you receive an indi-
vidual message or a PSTN message. You can also enable or disable it for position, 
polling and test messages. For PSTN, position and polling messages, automatic ac-
knowledge is disabled with an active DSC session.

Note 1: For individual message, the automatic acknowledgement is automatically dis-
abled, as required by law, when an RX call contains an error.

Note 2: For individual message, the auto acknowledgement message can not be sent 
when there are RT and/or DSC sessions.

1. Rotate the ENTER knob to select [DSC] on the [MENU] screen then push the 
knob.

2. Rotate the ENTER knob to select [ACK SETTINGS] then push the knob.

Default:
[AUTO (UNABLE)]

[AUTO (ABLE)]: Send 
ABLE acknowledgement 
automatically.
[AUTO (UNABLE)]: Send 
UNABLE 
acknowledgement 
automatically.

Sets reason for UNABLE. 
This menu item is only for 
use with PSTN. 

Default: [MANUAL] [AUTO (ABLE)]: Send automatic 
acknowledgement of position 
request.
[AUTO (UNABLE)]: Send 
automatic acknowledgement of 
no position information.
[MANUAL]: Send manual 
acknowledgement.

Default: [AUTO]
[AUTO]: Send automatic 
acknowledgement of polling request.
[MANUAL]: Send manual 
acknowledgement of polling request.

Default: 
[AUTO]

[AUTO]: Send automatic 
acknowledgement of test 
call.
[MANUAL]: Send manual 
acknowledgement of test 
call.

Default: [NO REASON]

Default:
[AUTO (ABLE)]

If you cannot use the 
frequency or mode 
specified by a sending 
station, [CAN'T USE CH] 
is automatically sent.  
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6.18 Special Messages
Permission to transmit NEUTRAL CRAFT and MEDICAL TRANSPORT is enabled or 
disabled as follows:

1. Rotate the ENTER knob to select [DSC] on the [MENU] screen then push the 
knob.

2. Rotate the ENTER knob to select [SPECIAL MSG] then push the knob.

3. Rotate the ENTER knob to select [NEUTRAL] or [MEDICAL] then push the knob.
4. Rotate the ENTER knob to select [ABLE] or [UNABLE] then push the knob.

6.19 How to Set Scan Frequencies
The [ROUTINE/DISTRESS SCAN] menus determine which DSC routine and distress 
frequencies to scan. Follow the instructions below to select/deselect DSC routine and 
distress frequencies to scan.

Routine frequencies

1. Rotate the ENTER knob to select [DSC] on the [MENU] screen then push the 
knob.

2. Rotate the ENTER knob to select [ROUTINE SCAN] then push the knob.

3. Rotate the ENTER knob to select [SCAN1] (2, 3, 4, 5 or 6) then push the knob.

4. Rotate the ENTER knob to select frequency band then push the knob.
5. Rotate the ENTER knob to select frequency desired then push the knob.

[INTL]: International channels
[LOCAL1/LOCAL2]: Local channels
[DIST]: Distress channels
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Note: Distress frequencies can be stored on the routine frequency memory. This is 
convenient for backing up the watch-keeping receiver.

Distress, urgency and safety frequencies

1. Rotate the ENTER knob to select [DSC] on the [MENU] screen then push the 
knob.

2. Rotate the ENTER knob to select [DISTRESS SCAN] then push the knob.

3. Rotate the ENTER knob to select frequency band then push the knob.

4. Rotate the ENTER knob to select [ON] or [OFF] as appropriate then push the 
knob.

Note: Regulations require that 2 MHz and 8 MHz and one more DSC distress frequen-
cy should be watched continuously. 2 MHz and 8 MHz cannot be turned off. Maximum 
three bands can be turned off.

6.20 Sound Setting
The [AUDIO] menu lets you set the volume for the following items:

Rotate the ENTER knob to select [AUDIO] on the [MENU] screen then push the knob.

• Key click on (setting: [1] - [3]) or off (setting: [0]) (Two beeps sound when a key inop-
erative in the ON mode (setting: [1] - [3]) is operated.)

• Speaker on or off with off hook for handset
• Volume of the receiving alarm for the safety and routine messages
• Turn sound alarm on or off for the distress alarm received from a ship in distress which 

is more than 500 NM from your ship.
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6.21 Alarm Lists
The [ALARM] menu shows all currently violated alarms. When an error occurs, a pop-
up message and the flashing error icon appear on the screen. Press the CANCEL key 
to close the pop-up message and stop the flashng of the error icon. When the error is 
removed, the error icon disappears.

Rotate the ENTER knob to select [ALARM] on the [MENU] screen then push the knob. 
The following screen appears.

There are seven kinds of errors: TX PLL UNLOCK, RX PLL UNLOCK, WR1 PLL UN-
LOCK, WR2 PLL UNLOCK, MAIN AMP HEATED, SHIP’S MAIN FAILURE, VC ER-
ROR.

Errors are displayed in the order shown above, not in the order of occurrence. An error 
is deleted from the list when the cause for the error is removed.

Default: [2]
Turn beep on (setting: [1] - [3]) 
or off (setting: [0]) when a key 
is pressed.

Default: [MUTE]
Turn the speaker on or off 
when the handset is off hook.

Rotate the ENTER knob 
to set volume then push 
the knob.

Default: [500NM]
Turn sound alarm on or off 
for the distress alarm 
received from a ship in 
distress which is more than 
500 NM from your ship.

Error icon

TX PLL UNLOCK
WR1 PLL UNLOCK
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7. NBDP SYSTEM OVERVIEW

7.1 How to Turn on the NBDP System
Turn on the terminal unit and the printer with their respective power switches.

Note 1: To power on the system, turn on the control unit then turn on the NBDP ter-
minal unit.

Note 2: The printer PP-510 prints messages. Refer to its operator's manual for oper-
ation.

7.2 Description of Equipment

7.2.1 Terminal unit
The terminal unit is a visual display incorporating a floppy disk drive (for IB-583) or an 
SD card drive (IB-585). To adjust the brilliance, press the Alt key while pressing the 
F6 key to lower the brilliance; the F7 key to raise it. Eight levels of brilliance are avail-
able.

When the terminal unit is turned on, the communication status screen, shown below, 
appears. This is where all phases of telex communications begin.

Communication status screen

TERMINAL UNIT IB-583
Power switchFloppy disk drive

PRINTER PP-510
Power switch

TERMINAL UNIT IB-585
Power switchSD card drive
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Features of the IB-583

The IB-583 has a battery (Type: CR2450-F2ST2L, Code no.: 000-144-941) on its 
TERM/CPU Board (16P0209) and its life is about six years. When the voltage of the 
battery gets low, the time is wrong. When this occurs, contact your dealer about re-
placement of the battery.

Russian mode

The terminal unit is fitted with both English and Russian modes. Select the desired 
mode as below:
"English-mode": Turn on the terminal unit while pressing the E key.
"Russian-mode": Turn on the terminal unit while pressing the R key.
This mode is stored.
In "Russian-mode", there are two input shift status; "English-shift" and "Russian-shift". 
In the "Russian-shift" status, the alphabet keys are used as Cyrillic keys.

Note 1: To switch between Russian and English input, press the Alt key while holding 
down the Shift key. (This is available in Russian mode only.) "Eng" or "Rus" appears 
on the top right of the screen. This shift status is not stored. When you turn on the pow-
er next time, you reset the shift status as necessary.

Note 2: The comma and period can not be entered in the "Russian-shift" status. To 
enter these characters, switch to the "English-shift" status.

Note 3:  can not be entered in "Russian-mode".  is replaced with "4" in 
NBDP communication.

7.2.2 Keyboard
The terminal unit is operated from the keyboard. Operation is simplified by the use of 
menus which you access by pressing a function key, labeled F1-F10 at the top of the 
keyboard. The figures below show the function menus and their corresponding func-
tion keys.

Keyboard for IB-583

Keyboard for IB-585

“Ë” and “Ъ” “Ч”
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@
2

#
3

$
4
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5

^
6
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=

&
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9 9

Back-
space

Home
8 8

)
0

Pg UpQ W E R T Y I {
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}
] \Tab

U
4

O
6

P
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Pg DnA S D F G H "
'

Enter
Enter

Caps
Lock J

1
K

2
L
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:
; +

End

Shift
Z X C V B N <

,
?
/ /

>
.

M
0 Shift

Ctrl

Ctrl Fn

Alt Alt Ins Del

Esc F3 F4 F5 F6 F7 F8 F9 F10 Num
Lock

Prt Sc

Sys Rq

Scroll
Lock

Pause

Break

F1

F11

F2

F12

5

_

-

~
,

�

.

F1: FILE
F2: EDIT
F3: OPERATE
F4: WINDOW
F5: STATION

F6: SYSTEM
F7: WRU
F8: HR
F9: OVER
F10: BREAK

Function keys

Do not use these keys.
The indication “ScrLk” means the Russian 
shift is active. (It does not mean “scroll lock”.)

F1: FILE
F2: EDIT
F3: OPERATE
F4: WINDOW
F5: STATION

F6: SYSTEM
F7: WRU
F8: HR
F9: OVER
F10: BREAK

Function keys
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Note 1: The correct letters may not be entered when connecting a keyboard except 
the supplied one.

Note 2: Both Russian and English input are available in the Russian mode. Put the 
keytop label supplied on the keyboard during the Russian mode.

Note 3: The carriage-return and line-feed codes "CR LF" are automatically sent with 
pressing the Enter key during NBDP communication. Press the ← or ↓ key if you want 
to send only "CR" or "LF".

Note 4: "Letter Shift" and "Figure Shift" are automatically inserted if necessary. If you 
want to send them purposely, press the following keys:
• "Letter Shift": Ctrl + Shift + L
• "Figure Shift": Ctrl + Shift + F
• "NOINF" ("Cyrillic Shift" in Russian mode): Ctrl + Shift + R

Note 5: Do not connect or disconnect the keyboard during operating the terminal unit.

7.3 Function Keys, Menu Operation
The function keys at the top of the keyboard control most of operations through a 
menu system. Most of the screenshots on this manual are for IB-585.

7.3.1 Menu conventions

Reverse highlighting

The cursor-selected menu item is displayed with white characters on a black back-
ground.

Underline

The underline shows the currently selected option. In the figure below, for example, 
[ARQ], [Channel] and [ON] are underlined.

[Station Entry] screen

Reverse 
highlighting

Underline
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7.3.2 Menu overview

Menu selection

Press a function key to open a menu. 
To display the [File] menu, for exam-
ple, press the function key F1.

Selection of menu items and op-
tions

Press a numeric or alphabet key to se-
lect a menu item. You can also select a 
menu item to press the ← or → key 
then press the Enter key. Menu op-
tions can be selected by the ← or → 
key. After selecting an option, press 
the Enter key to register your selec-
tion.

How to close the menu

Press and hold down the Esc key for over a second to close the menu.

7.3.3 Function key description

Function key F1: [File] menu

The [File] menu is where you create, open, save and print telex messages. Floppy 
disks or SD cards are also formatted by this menu.

1: Open a new untitled window.
2: Open files saved on floppy disks or SD cards.
3: Close files with saving or discarding.

4: Delete files on floppy disks or SD cards.

5: Rename files on floppy disks or SD cards.

6: Turn real time printing on or off.
7: Print files on floppy disks or SD cards.
8: Stop printing and clear the print buffer.

9: Clear the communication buffer.

0: Format an SD card for IB-585, or a floppy disk 
for IB-583.
A: Execute this menu before removing an SD 
card.
B: Open a macro window.
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*1: [Floppy Disk Format] for IB-583
*2: Only for IB-585
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Function key F2: [Edit] menu

The [Edit] menu provides a full line of editing features.

Function key F3: [Operate] menu

The [Operate] menu mainly controls transmission and reception.

1: Cancel the last change (cut, copy or paste).
2: Remove the selected text and store it in the 
paste buffer. (Previous text in the paste buffer is 
cleared.)
3: Copy the selected text and store it in the paste 
buffer. (Previous text in the paste buffer is 
cleared.)
4: Insert the text stored in the paste buffer at the 
current location of the cursor.
5: Select the entire current file for cut or copy.
6: Search a word or a character string.
7: Replace a word with a different word or char-
acter string.
8: Put the cursor to the top line of the current file.
9: Put the cursor to the last line of the current file.
0: Move the cursor to the desired line in the cur-
rent file.
A: Switch between the display window 1 and 2.

1: Select a station on the station list.
2: Enable macro operation. For details, see 
section 10.10.
3: Select a file (to transmit).
4: Stop sending a file.
5: Start/stop frequency scanning.
6: Select communication mode for reception; 
AUTO, ARQ, FEC.
Note: Do not select DIRC.
7: Timer programming.
8: Set TX mode and subscriber's ID number and 
start manual calling.
9: Set TX and RX frequencies and start waiting 
for reception.
0: Set ITU or user channel and start waiting for 
reception.
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1: Call Station

3: File to Send
4: Cancel Sending

5: Scan (Start/Stop)

6: Manual Reception

7: Timer Operation

8: Manual Calling
9: Set Frequency
0: Set Channel*

Operate

2: Macro Operation 

*: Only for IB-585
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Function key F4: [Window] menu

The [Window] menu lets you display the corresponding data of the window below.

Function key F5: [Station] menu

The [Station] menu provides for storage of stations, timer program setup, user channel 
setup, and entry of various ID codes.

1: Display desired calendar month and year. To 
change year or month, select item with the ↑ or 
↓ key and change setting with the ← or → key.
2: Display all distress frequencies (see the fol-
lowing table).
3: Turn on or off the screen saver function. For 
details, see section 8.7.

1: Register stations.

2: Register timer programs.

3: Register scan groups for scanning.

4: Register user channels.

5: Register own ship's answerback code.
6: Register own ship's group ID code (4 or 5 dig-
its).
7: Register own ship's group ID code (9 digits).
8: Register own ship's selective ID code (4 or 5 
digits).
9: Register own ship's selective ID code (9 dig-
its).
Note: For IB-585, the numbers after 5 are 
moved up.
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1: Station Entry

2: Timer Operation Entry

3: Scan Entry

4: User Channel Entry*

5: Answerback Code Entry

6: Group ID Entry (4/5 digit)
7: Group ID Entry (9 digit)
8: Select ID Entry (4/5 digit)
9: Select ID Entry (9 digit)

Station

*: Only for IB-583
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Function key F6: [System] menu

The [System] menu is mainly for use by technicians and contains diagnostic tests. To 
change settings, select [Change] from the item [Setup] and operate the arrow keys to 
select item and option. Press the Enter key to register the selection and close the 
menu.

Menu item Function

[Setup] Lock, change settings, restore default system settings.

[Slave Delay] Set the length of the slave delay timing from the end of RX to the start 
of TX in the ARQ mode. The default setting is suitable in most cases. 
This item cannot be adjusted by the user.

[TX/RX MSG 
Save]

Turn on to automatically save incoming and outgoing messages to a 
floppy disk or a SD card. "Log" appears at the top of the screen when 
on.

[Edit Before 
sending]

[OFF] transmits key operation one by one. [ON] transmits message 
only when the Enter key is pressed after confirming text typed.

[TX POWER] 
(only for
IB-585)

Change output power during transmission. ([HIGH], [MID], [LOW] (for 
FS-1575/2575), [LOW1] (for FS-5075), [LOW2] (for FS-5075))

[Header/Foot-
er] (only for
IB-585)

Turn on or off the indication of header and footer. When starting trans-
mission, display time & date for starting transmission, MMSI for com-
munication party, TX and RX frequencies. When ending transmission, 
display time & date for ending transmission.

[Time System] Select time system.
[OFF]: No time indication, [UTC]: Coordinated universal time,
[SMT]: Local time, [JST]: Japan standard time

Setup

Slave Delay

TX/RX MSG Save
Edit before Sending
TX Power*
Header/Footer*

Time System
Time & Date
Window Color
Self Test

Lock  Change   Default

12 msec (10 - 50 msec)

OFF  ON
OFF  ON
HIGH  MID  LOW
OFF  ON

OFF UTC SMT JST
10-Apr-2012  10:00:00

System

*: Only for IB-585

ARQ 
mode 
signal 

sequence

3 char. RX 3 char. RX

Slave Delay 
Timing

RX end TX start

ACK signal
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Function key F7: WRU (Who Are You?)

In the ARQ mode, request other station's answerback code.

Function key F8: HR (Here Is)

In the ARQ mode, send your ship's answerback code.

Function key F9: OVER

In the ARQ mode, switch the direction of traffic; the information receiving station 
switches to the information sending station, the information sending station switches 
to the information receiving station.

Function key F10: Break

Disconnect the line or cancel the standby.

[Time & Date] Enter date and time manually. If a navigation device is connected, the 
time is automatically set when the power is turned on or whenever the 
time system is switched. Manual entry takes priority over automatic 
entry. This item cannot be adjusted when using [UTC] or [JST].

[Window
Color]

Select display colors. For details, see section 8.6.

[Self Test] Start diagnostic test.

Menu item Function
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8. NBDP PREPARATIONS

This chapter provides the procedures necessary for preparing the NBDP terminal unit. 
For automatic telex, you need to register the following:

• Your ship's ID and answerback codes mandatory
• Stations
• Timer programs
• Scan channel groups
• User channels

8.1 Registration of Answerback & ID Codes
Enter your ship's answerback and ID codes as shown below.

Note: The answerback and ID codes cannot be changed once entered; be sure to cor-
rectly enter the codes.

8.1.1 How to register answerback code
1. Press the function key F5 then 

the 4 key for IB-585 or the 5 
key for IB-583 to open the [An-
swerback Code Entry] screen.

2. Enter your ship's answerback code (numbers, space, 4 capital letters, space, X) 
then press the Enter key. The prompt "OK/Cancel" asks for confirmation of the 
data.
Example of answerback code: 123456789 FURU X.

3. If the code is correct, press the Enter key again. For final confirmation of the data, 
the "Caution" shown in the illustration below appears.

Message for confirmation of code entered
4. If the code is correct, press the Enter key again.
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8.1.2 How to register ID codes
1. Press the function key F5 then the 5, 

6, 7 or 8 key for IB-585 to enter the 
Group ID Code (4 or 5 digits), Group 
ID Code (9 digits), Select ID Code (4 
or 5 digits) or Select ID Code (9 dig-
its), respectively. (For IB-583, press 
the function key F5 then the 6, 7, 8 or 
9 key.)

2. Enter Group ID or Select ID then press the Enter key. A prompt asks for confir-
mation of the data.

3. If the ID is correct, press the Enter key. For final confirmation of the data, the 
"Caution" shown in the illustration below appears.

Message for confirmation of code entered
4. If the ID is correct, press the Enter key again.

8.2 User Channels
The user channels can be used in scanning entry and station entry.

For IB-585, the user channels are set by the transceiver unit. See section 6.2. For IB-
583, the user channel list provides storage for up to 100 user channels, numbered 0 - 
99. See the following paragraphs.

8.2.1 How to register user channels
1. Press the function key F5 then the 4 key to open the [User Channel Entry] screen.

2. If [Create] is not underlined, press the →, ↑ and Enter keys to underline it.
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3. With [Channel] selected, enter a channel number.
Note 1: 100 channels can be registered. When you attempt to register more, the 
message "Channel memory is full. Press any key to escape." appears. In this case 
delete unnecessary channels to register new ones.
Note 2: If the channel entered already exists, the message "Channel by that num-
ber already exists. Press any key to escape." appears. Press any key then enter 
another number.

4. Press the ↓ key to select [Tx Freq]. Enter TX frequency.
5. Press the ↓ key to select [Rx Freq]. Enter RX frequency.
6. Press the Enter key. The [OK/Cancel] confirmation window appears.
7. Press the Enter key. Channel number entered appears in the [Channel List].
8. Press the Esc key to close the menu.

8.2.2 How to edit/delete user channels
1. Press the function key F5 then the 4 key to open the [User Channel Entry] screen.
2. Press the ↓ key to select a channel from the [Channel List].
3. Press the → key then the ↓ key to select [Change] and press the Enter key.
4. Do one of the following:

Edit channel: Use the ↑, ↓ and Backspace keys to make corrections.
Delete channel: Erase channel number with the Backspace key.

5. Press the Enter key twice.
6. Press the Esc key.

8.3 Station List
The station list stores up to 50 stations, one frequency pair (RX and TX) per station. 
For stations which have more than one frequency pair, you can add a suffix to the sta-
tion name to denote multiple frequency pairs. For example, station name FURUNO 
followed by -1, -2, -3, etc. for each frequency pair required.

8.3.1 How to register stations
1. Press the function key F5 then the 1 key to open the [Station Entry] screen. On 

the right side of the screen, [Create] and [Change] are shown.
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2. If [Create] is not underlined, press the →, ↑ and Enter keys to underline it.
3. With [Station] selected, enter station name using up to 18 characters.
4. Press the ↓ key to select [ID Code]. Enter station ID code.
5. Press the ↓ key to select [Mode]. Select either communication mode with the ← 

or → keys.
[ARQ]: Automatic Retransmission Request
[FEC]: Forward Error Correction

6. Press the ↓ key to select [CH/Table]. Select [Channel] or [ScanTable].
7. Press the ↓ key to select [Num/Table].

If you selected [Channel] at step 6, enter ITU channel number (see Appendix 2) 
or User channel number. Go to step 10.
If you selected [ScanTable] at step 6, press the → key to show the scan group list 
registered. For the scan group, refer to section 8.5.

8. Select a scan group name by using the ↓ or ↑ key then press the Enter key. For 
IB-583, go to step 10. For IB-585, go to the next step.

Example window for Scanning Group List
9. Press the ↓ key to select [Rephasing]. Select [ON] or [OFF].

Note: The default setting is [ON]. Select [ON] under normal use. The disconnec-
tion by error is processed quickly with [OFF] when communicating with the party 
which does not have rephasing function.

10. Press the Enter key. The prompt [OK/Cancel] asks for verification of data.

11. If the data is correct, press the Enter key. (To cancel entry, press the ↓ key to se-
lect [Cancel] then press the Enter key. Data entered are erased.) The station 
name entered at step 3 appears at the [Station List] window.

12. To register other stations, press the Enter key twice then repeat steps 3 through 
10.

13. Press the ↓ key. Check data on the [Station List] for correctness. The stations dis-
played in reverse video on the [Station List] are displayed on [Station Set Up].

14. Press the Esc key to quit.

Note 1: If you enter a station which already exists, the indication "Station by that name 
already exists. Press any key to escape." appears. Press any key to return to the [Sta-
tion List]. Check the list.

Note 2: The station entry beginning with "DSC" is special entry which is automatically 
registered by DSC function.
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8.3.2 How to edit/delete stations
1. Press the function key F5 then the 1 key to open the [Station Entry] screen.
2. Press the ↓ key to select a station name from the [Station List].
3. Press the → key then the ↓ key to select [Change] and press the Enter key.
4. Do one of the following;

Edit station: Use the ↑, ↓ and the Backspace keys to make corrections.
Delete station: Erase station name with the Backspace key.

5. Press the Enter key twice.
6. Press the Esc key.

8.4 Timer Programming
A built-in timer allows you to automatically receive and transmit files. 10 timer pro-
grams can be registered. To enable timer operation, see section 10.6.

8.4.1 How to register timer programs
1. Press the function key F5 then the 2 key to open the [Timer Operation Entry] 

screen.

2. If [Create] is not underlined, press the →, ↑ and Enter keys to underline it.
3. With [Operation] selected, enter a suitable operation name on the [Operation] line. 

Any alphanumeric characters can be used.
Note: If the operation name entered already exists, the message "Operation 
name already exists. Press any key to escape." appears. Press any key and 
change the operation name.

4. Press the ↓ key to select [Station].
5. Press the → key to display [Station List] (which you registered stations in the pre-

vious paragraph).
6. Press the ↓ or ↑ key to select a station then press the Enter key.
7. Press the ↓ key to select [Start Time]. Enter start time, in 24-hour notation. To 

have the operation start at 8:35 a.m., for example, the keying sequence would be
0 8 3 5 0 0.
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Press the � key to show the station list, the file list.
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8. Press the ↓ key to select [Stop Time]. Enter stop time, in 24-hour notation.
9. Press the ↓ key to select [Receive/Send]. Select operation category; [Receive] or 

[Send]. If you select [Send], go to step 10. For [Receive], go to step 12.
10. For [Send], insert the floppy disk or the SD card to the drive then press the ↓ key 

to select [File to Send].
11. Press the → key to open the TX window, select a file, then press the Enter key 

twice.
12. Press the Enter key. A confirmation message appears.
13. Press the Enter key. The operation name appears in [Timer Operation List].
14. To enter another timer program, press the Enter key twice and repeat steps 3 to 

13.
15. Press the Esc key to close the menu.

8.4.2 How to edit/delete timer programs
1. Press the function key F5 then the 2 key to open the [Timer Operation Entry] 

screen.
2. Press the ↓ key to select a timer program name from the [Timer Operation List].
3. Press the → key then the ↓ key to select [Change] and press the Enter key.
4. Do one of the following;

Edit program: Use the ↓, ↑ and the Backspace keys to make corrections.
Delete program: Erase operation name with the Backspace key.

5. Press the Enter key twice.
6. Press the Esc key.

8.5 Scan Channel Groups
You can store up to 10 scan groups, 20 channels per group.

The NBDP terminal unit can control radio equipment through channel scanning. In the 
FEC mode, the radio equipment scans a number of channels (according to your se-
lection), stopping when an synchronous code is found. In the ARQ mode it stops when 
your own ID code is detected in an incoming signal. Also, in the ARQ mode, the trans-
mitter is then tuned to the corresponding transmitter frequency, the communication 
link is established and the traffic is automatically exchanged. Scanning resumes once 
the link is disconnected.
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8.5.1 How to register scan channel groups
You can register ITU and user scan channels as follows:

1. Press the function key F5 then the 3 key to open the [Scan Entry] screen.

2. If [Create] is not underlined, press the →, ↑ and Enter keys to underline it.
3. With [Group Name] selected, enter a suitable group name.

Note 1: 10 group names can be entered. If you attempt to enter more, the mes-
sage "Scan group memory is full. Press any key to escape." appears. Press any 
key then delete unnecessary group names to enter new ones.
Note 2: If the group name already exists, the message "Scan group by that name 
already exists. Press any key to escape." appears. Press any key and change the 
scan group name.

4. Press the ↓ key to select [Ch Dwell Time]. Enter channel dwell time in seconds. 
Dwell time is the time in seconds the receiver waits on each channel in a scan 
group before it selects the next frequency.

5. Press the ↓ key to select [(Receiving) Mode] then select the receiving mode;
[AUTO], [ARQ] or [FEC].
Note: [AUTO] is used to register a scanning channel group when both [ARQ] and 
[FEC] exist in the same Scanning Channel Group. When you select a scan group 
by the [Call Station] menu, the communication mode is controlled by the station 
entry’s mode.

6. Press the ↓ key to select [Auto Search]. Select [ON] or [OFF].
[ON]: The radio stops scanning when it finds the strongest signal (highest S/N ra-
tio). To find the strongest signal, the radio scans all channels, which can take 
some time. Therefore, use this setting where the signal propagation is poor.
[OFF]: The radio stops scanning on the first signal it finds. It is recommended to 
select [OFF] when the signal propagation is good.

7. Press the ↓ key to select line No. 1 in the [Scanning Set Up] window.
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8. Enter the channel number (ITU or user channels) then press the → key to select 
[Scan].
Note: If you enter an invalid channel, the message "Channel by that number does 
not exist. Press any key to escape." appears. Press any key then enter a valid 
channel.

9. Press the ↓ key to select line No. 2. Enter a channel number.
10. Enter other channel numbers then press the Enter key. A confirmation message 

appears.
11. Press the Enter key again to save the data. The group name is displayed in the 

[Scanning Group List] window.
12. To continue, press the Enter key twice then repeat steps 3 to 11.
13. Press the Esc key to close the menu.

Note 1: An ARQ from another station continues for 56 seconds. However, you 
cannot receive via ARQ if the number of registered scan frequencies multiplied by 
the channel dwell time is greater than 56 seconds.
Note 2: The selective FEC mode requires authentication of call ID. However, you 
cannot receive via the selective FEC mode if the Call ID is not received with the 
frequency for scan detention time. If you might be called via the selective FEC 
mode, wait to receive the call on a single frequency, which you can set with the 
[Set Frequency] in the [Operate] menu.

8.5.2 How to edit/delete scan channel groups
1. Press the function key F5 then the 3 key to open the [Scan Entry] screen.
2. Press the ↓ key to select scan group name from the [Scanning Group List].
3. Press the → key then the ↓ key to select [Change] and press the Enter key.
4. Press the ↓ key to place the cursor on the field (channel) to change.
5. Do one of the following:

Edit channels: Press the Backspace key to delete the channel number then enter 
a new channel number.
Add channels: Enter a channel number on a blank line.
Delete scan group: Delete the group name with the Backspace key.
Disable channels temporarily: Press the ← key to underline [Pass].

6. Press the Enter key twice.
7. Press the Esc key to close the menu.

8.6 How to Change the Window Color
You can select and change the window color.

IB-583

1. Select [Change] from [Setup].
2. Press the ↓ key to select [Window Color] 

then press the Enter key.
Window Color Change 

Window Color Setup
Default Color

To Change: ENTER  To quit: ESC
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3. With [Window Color Setup] selected, 
press the Enter key.

4. Press the ← or → key to select the item 
to change: [BASE WINDOW], [BACK 
SCROLL], [EDIT 1-2], [FUNCTION], 
[SUB MENU 1-3], [MESSAGE].

5. Press the ↓ key to select [Fore Color].
6. Press the ← or → key to select color: [L-WHITE], [BLACK], [BLUE], [GREEN], [CY-

AN], [RED], [MAGENTA], [BROWN], [WHITE], [GRAY], [L-BLUE], [L-GREEN], [L-
CYAN], [L-RED], [L-MAGENTA], [YELLOW].

7. Press the ↓ key to select [Back Color].
8. Press the ← or → key to select color.

9. Press the ↑ key to select [Window].
10. Repeat the steps 4 to 9 to set other colors.

11. Press the Enter key followed by the Esc key.

IB-585

1. Press the function key F6 to open the [System] menu.
2. Press the → key to select [Change].
3. Press the ↓ key to select [Window Color] then press the Enter key to open the 

[Window Color Edit] window.

4. Press the ← or → key to select [1], [2] or [3]. The selected preset color is reflected 
on the [Window Color Edit] window. 

5. Press the Enter key to reflect the selected preset color on the screen.
If you want to reset or change the preset settings, do the following:

1. Select [1], [2] or [3] then press the ↓ key.
2. To reset the settings, press the Enter key with [Load Default] selected.

To change the settings, press the ↓ key. Go to step 3.
3. Press the ← or → key to select an option in [Window] and press the ↓ key.
4. Press the ← or → key to select a color in [Fore Color] and press the ↓ key.
5. Press the ← or → key to select a color in [Back Color] and press the ↓ key.

Note: You cannot select the same color between [Fore Color] and [Back Color].
6. To increase the brightness, press the F7 key while pressing and holding the Alt 

key. To decrease the brightness, press the F6 key while pressing and holding the 
Alt key. The changed brightness setting is underlined.

7. To confirm the selections, press the Enter key. To cancel the selections, press the 
Esc key. The window closes.

Window Color Setup

Window  : [BASE WINDOW ]  
Fore Color : [L-WHITE  ]     
Back Color : [BLUE  ]

To Change: ENTER    To Change Value: L<=>R

Window Color Edit
Target Preset          1      2      3
Load Default

Edit Color
 Window             [   BASE WINDOW    ]  
 Fore Color            [   BLACK                     ]     
 Back Color            [   WHITE                     ]
 Brightness                   0 1 2 3 4 5 6 7 8 9 10

To Change: ENTER    To Change Value: L<=>R
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Default for each preset

8.7 Screen Saver Function for IB-585
Turn on or off the screen saver function for IB-585. When there are no operation for 10 
minutes, the screen is black and "IB-585" appears at random.

Note: This function is not available during standby and communication modes.

1. Press the function key F4 then the 3 key to select [Screen Saver].

2. Press the → key to select [ON].
3. Press the Enter key to close the menu.

Preset1 
(original)

Preset2
(day)

Preset3 
(night)

Brightness 10 10 5

Base window Fore color L-White Black L-White

Back color Blue L-White Black

Back scroll Fore color L-White Black Black

Back color Blue White Gray

Edit1 Fore color Black Black Black

Back color Green White Gray

Edit2 Fore color Magenta Black White

Back color White L-Cyan Blue

Function Fore color Black Black L-White

Back color Cyan L-White Black

Sub menu1 Fore color Black Blue L-Cyan

Back color White L-White Black

Sub menu2 Fore color Blue Blue L-Green

Back color White White Black

Sub menu3 Fore color White L-White L-Magenta

Back color Black Blue Black

Message Fore color White L-White White

Back color Magenta Blue Blue
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9. NBDP FILE OPERATIONS

This chapter mainly describes how to create, save, open, edit and print files. The [Edit] 
menu provides a full lineup of editing facilities, including search and replace.

9.1 How to Open and Close Files
To create a telex message, you need to make a new file with the File Open command. 
When you open a new file, it is placed (opened) in one of two working areas. When 
both working areas are occupied, you must close a file to open a new file. This is done 
with the File Close command.

How to open a file

9.2 How to Create Files
There are two modes for creating the files; for messages and for macros.

• For messages: You can enter only the characters which are sendable in NBDP 
comminication. Press the function key F1 then the 1 key to create a message file.

• For macros: You can enter only the characters ( ) which are used in a macro 
command. Press the function key F1 then the B key to create a macro file.

1. Press the function key F1 to open the [File] menu.

1

2

Floppy Disk Memory 
or SD Card Memory

File 1

File 2

File 3 Display Unit's Memory 
(Working area)

One of 
two Display

Switchable. Select [Change 
Text] on the [Edit] menu.
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2. Press the 1 key to select [New]. The title bar shows [UNTITLED 1] or [UNTITLED 
2]. The cursor marks the location where you can type text.

3. Type your message.

Note: Do not use the lower case letters, or the symbols #, &, *, $ and % in telex mes-
sages. Also, do not put "$$$" in the middle of a TX message, but at the end. The com-
munication line is automatically disconnected when this string is detected.
To enter "$$$" when editing a message, press the Ctrl + Q keys for IB-585. For IB-
583, enter "$$$" with using the $(4) key.

9.3 How to Save a File
IB-583

Use only 2HD type floppy disks. Insert the floppy disk with care. Rough handling can 
destroy the information stored inside. To eject the disk, press the Eject button on the 
left side of the floppy disk drive then remove the disk. Do not eject the disk while the 
operating lamp is lit, otherwise the contents of the disk can be damaged.

IB-585

Use SD cards 2GB or below, or SDHC cards 32GB or below. Insert or eject the SD 
card with care when the power is off. Rough handling can destroy the information 
stored inside. When ejecting the SD card with power-on, execute [Remove SD Card] 
in the [File] menu (see "Function key F1: [File] menu" on page 7-4) then remove the 
SD card.

Note: When using the SD card after executing [Remove SD Card], remove the SD 
card then insert it.

9.3.1 How to format floppy disks or SD cards
Before you save a file to a floppy disk or an SD card, the disk or the card must be for-
matted. Format the disk or the card as below.

1. Press the function key F1 to open the [File] menu.
2. Insert a new floppy disk or SD card in the drive.
3. Press the 0 key to select [Floppy Disk Format] or [SD Card Format].
4. Press the ↑ key to select [Yes] then press the Enter key. The screen shows for-

matting progress as below. After formatting has been completed, control is re-
turned to the standby screen.

SD Card Format
9% 

[Floppy Disk Format] 
for IB-583
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9.3.2 How to save a file
1. Press the function key F1 to open the [File] menu.
2. Press the 3 key to select [Close]. The [Close Text] window appears.

3. With [Yes] selected, press the Enter key.
4. Enter the file name, using up to eight characters. You can use any alphabet or nu-

meric on the keyboard. You can not use the symbols shown below. You can add 
an extension at the end of the file name, for example, .TXT, to distinguish text files 
from macro files.

5. Press the Enter key.

9.4 How to Edit Files

9.4.1 How to cut and paste text
You can delete, move and copy text by using the [Cut], [Copy] and [Paste] functions 
in the [Edit] menu.
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How to cut text

1. Place the cursor on the first character of the text to cut.
2. Highlight the text to cut by pressing and holding the Shift key while pressing the 

→ key. If you highlighted the text which you do not want to cut by mistake, press 
the ← key to adjust the highlight.

The highlight
3. Press the function key F2 then the 2 key. Or press the Del key. The highlighted 

text is cut and the remaining text is reformatted.
If you made a mistake, you can restore the text. Select [Undo] in the [Edit] menu.

How to paste text

To paste the cut text to a new location, do the following:

1. Place the cursor at the exact spot in the message where the cut text is to start.
2. Press the function key F2 then the 4 key. Or press the Ins or Insert key.

9.4.2 How to copy and paste text
You can copy a portion of text and paste it elsewhere.

1. Select the text to copy (see "How to cut text" on page 9-4).
2. Press the function key F2 then the 3 key. The text selected is copied to the paste 

buffer memory where the cut or copied text is stored. The screen returns to the 
normal screen.

3. Place the cursor at the exact spot in the message where the copied text is to start.
4. Press the function key F2 then the 4 key.

9.4.3 Select all
The [Select All] feature lets you select all of the file currently displayed. This feature is 
useful when you want to combine the files. The procedure below explains how to place 
the file loaded in working area 1 onto the end of the file loaded in working area 2.

1. Load the file to copy from a floppy disk or an SD card in working area 1.
2. Press the function key F2 then the 5 key. The entire file appears in reverse video.
3. Press the function key F2 then the 3 key. The file is placed in the paste buffer 

memory.
4. Load the file to combine in working area 2.
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5. Place the cursor at the exact spot in the message where the text now in the paste 
buffer memory is to start then press the Ins or Insert key.

Copy and paste flow diagram

9.4.4 How to search text
The [Search] feature lets you search for text in a forward or backward direction.

1. Display a text and press the function key F2 then the 6 key. The [Search] window 
appears.

2. Type the word to find.
3. Press the → key.
4. Press the ↑ or ↓ key to select [Forward] or [Backward] to search the file in a for-

ward or backward direction respectively from the cursor position.
5. Press the Enter key to begin the search.
When the unit finds the word, the cursor stops at the first character of the word. Press 
the Enter key to continue the search. If the string could not be found, the message 
"Not Found (To quit: ESC)" appears. Press the Esc key to quit.

9.4.5 How to replace text
The [Replace] feature helps you to replace a word or phrase with another word or 
phrase in a file.

1. Press the function key F2 then the 7 key. The [Replace] window appears.

2. Type a word to replace on the [Search string] line.

1

3

2

4

Floppy Disk 
or SD card

Working 
Area 1

Working 
Area 2

Paste 
Buffer 
Memory

Open 
file

Open 
file

Transfer 
(copy)

Paste (Combine)
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3. Press the ↓ key to select [Replace with] then type a new word.
4. Press the → key.
5. Press the ↑ or ↓ key to select [Forward] or [Backward] to search the file in a for-

ward or backward direction respectively from the cursor position.
6. Press the → key.
7. Press the ↑ or ↓ key to select whether you want to be queried or not each time the 

word is found.
[Query]: Stop at each occurrence of the word to answer yes or no for replacement.
[All]: Replace every occurrence of the word without confirmation.

8. Press the Enter key to start the replacement.

9.4.6 Goto line
The [Goto Line] feature places the cursor at the head of a line desired.

1. Press the function key F2 then the 0 key. The [Goto Line] window appears.

2. Key in a line number then press the Enter key. The cursor shifts to the head of the 
line selected.

9.4.7 Goto top, Goto bottom
You can easily go to the top or bottom line of a file. Press the function key F2 then the 
8 key to go to the top line; press the function key F2 then the 9 key to go to the bottom 
line. Note that this feature can also be executed on the editor screen by pressing the 
Home or End key.

9.5 How to Open Files
Two working areas (called working area 1 and working area 2) are provided to which 
you can load a file, and one file can be displayed on the LCD.

9.5.1 Open a file
1. Insert the floppy disk or the SD card which contains the file to open.
2. Press the function key F1 to open the [File] menu.
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3. Press the 2 key. A list of files on the floppy disk or the SD card appears.

4. Press the ↑ or ↓ key to select a file.
5. Press the Enter key. The file appears and the title bar shows the file name. You 

can repeat this procedure to load another file into a working area.

Note: When two working areas have been opened, the close confirmation window ap-
pears. In this case, select [Yes] or [No] then press the Enter key to close an open file 
in order to open another file.

9.5.2 Switch between files
Two files can be opened and one file is displayed on the LCD. To switch between files, 
do the following:

1. Press the function key F2.
2. Press the A key to switch between the files.

9.6 How to Rename Files
To rename a file, do the following:

1. Press the function key F1.
2. Press the 5 key.
3. Press the ↑ or ↓ key to select a file to rename then press the Enter key.
4. Enter a new name.
5. Press the Enter key.

9.7 How to Save a File Under a New Name
You can save a file under a new name as follows:

1. Open a file.
2. Edit the file as necessary.

���������

	
�������������������
�����������������������������������������
���� !����"���������� #�����$����%�� "�
	�&�� !���������������'(�����()*+)�*��,�('
����������������������(*�����()*+)�*��-�.*
����(�����������������'������()*+)�*��/�('
����.�����������������0*�����()*+)�*�(*��-
1�$2������������������-/�����()*+)�*��-�(.
��������������������
3�$ ��4�
�5������������������

+�� !�6��� 6��������������������+'+***�75��6�3���

�
�6�!�4�����1��8���
�9 �:����2������
�;< �������



9.  NBDP FILE OPERATIONS

9-8

3. Press the function key F1.
4. Press the 3 key to save the file.
5. Press the Y key.
6. Press the Backspace key to erase the original name then enter a new name.
7. Press the Enter key.

9.8 How to Delete Files
Insert the floppy disk or the SD card in the drive and do the following to delete unnec-
essary files.

1. Press the function key F1.
2. Press the 4 key.
3. Press the ↑ or ↓ key to select the file to delete then press the Enter key.
4. Press the Enter key again. (To cancel, press the ↓ key to select [NO] then the En-

ter key.)

9.9 Real Time Printing
An incoming or outgoing message can be printed out while it is being received or 
transmitted.

1. Press the function key F1 to open the [File] menu.
2. Press the 6 key to turn real time printing on or off.
When the real time printing is on, "Print" appears in reverse video at the top of the 
screen. The sent messages are printed in bold face and the received messages are 
printed in normal type face.

9.10 How to Print Files
You can print files stored on the floppy disks or the SD cards as follows:

1. Press the function key F1.
2. Press the 7 key.
3. Press the ↑ or ↓ key to select a file then press the Enter key.
4. Press the Y key.
To stop printing at any time, press the function key F1 then the 8 key. If the file could 
not be printed, the message "Cannot print. Check connection between printer and ter-
minal. Press any key to escape." is displayed.
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10. NBDP TRANSMISSION,
RECEPTION

This chapter mainly shows you how to transmit and receive telex messages.

10.1 Manual Calling

The simplest way to communicate with a telex subscriber is manual calling. For the 
ARQ mode, you can display beforehand the message to send, or type your message 
manually.

1. Press the function key F3 to open the [Operate] menu.

2. For IB-583:
Press the 9 key to select [Set Frequency].

Before calling, watch the intended TX 
frequency carefully to confirm that is 
unoccupied.

NOTICE

1: Call Station

3: File to Send
4: Cancel Sending

5: Scan (Start/Stop)

6: Manual Reception

7: Timer Operation

8: Manual Calling
9: Set Frequency

Operate

2: Macro Operation 
1: Call Station

3: File to Send
4: Cancel Sending

5: Scan (Start/Stop)

6: Manual Reception

7: Timer Operation

8: Manual Calling
9: Set Frequency
0: Set Channel

Operate

2: Macro Operation 

For IB-583
For IB-585
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